July Program

PIZZA PARTY

Yes folks, once again it is time for our
infamous ApplePickers Pizza Party,

where we buy the pizza and you get
to eat it. (Dine in only, no carry out!)

According to my little bird on the
street, it will be held at
Donato’s Pizza at 1305 E 86th Street
from 7:00 to 8:45 p.m.

Upcoming Meetings

Main Meetings
July 8th

Business Meetings are now
Virtual (See Website Forums)
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ApplePickers Main Meeting

We meet the second Wednesday of each month,
6:30-7:00 p.m. social time, main meeting 7:00-8:45
p.m. at the Fishers Library. 5 Municipal Dr. just north
of 116th St. in Fishers. Visitors are always welcome to
come and join us.

ApplePickers Business Meeting

The business meeting is held via the ApplePickers
“Virtual Business Meeting” forum topic. Any
member is welcome to post in that topic stating
their opinions on what the club should be doing.

The third Monday of each month, Apple Represen-
tative Greg Willmore hosts the Mac Programmer’s
SIG. You should email Greg for specific information.
willmore@apple.com Location varies.

Final Cut Pro User Group

The INDYFCPUG meets the fourth Tuesday of each
month from 7:00-9:30 p.m. Since the location may
vary, please be sure to check their website.


http://www.hepl.lib.in.us/
http://maps.google.com/maps?f=q&hl=en&q=Fishers+Library,+Fishers,+IN&ll=39.911843,-86.060371&spn=0.154844,0.246506&om=1
mailto:willmore@apple.com
http://www.indy-fcpug.org/

ApplePickers Officers

President Vacant

Public Relations Gareth Souders
Past President Bob Carpenter
Secretary Irv Haas
Treasurer Ron Beechler
WebMaster Steve Johnson

president@applepickers.org
pr@applepickers.org
bobc@applepickers.org
irv@applepickers.org
ronb@applepickers.org
webmaster@applepickers.org

Newsletter Production

Editor this month Randy Marcy
Editor next month Bob van Lier
The Review Guru Irv Haas

randy@applepickers.org
bobv@applepickers.org
irv@applepickers.org

About the ApplePickers

ApplePickers is a not-for-profit educational organiza-
tion. We are made up of volunteers who donate their
time for the community advancement of computing.
We are in the business of giving away information. All
are welcome to join and we encourage you to get in-
volved. Contact anyone mentioned above or write to:
ApplePickers, P.O.Box 20136, Indianapolis, IN., 46220

Remember that ApplePickers is here to help you.
This help comes from our many members who
give of their time and talents to the group. Please
help us to help you by giving something in return.

Opinions expressed herein are those of the authors
and may not be construed as the official views of the
ApplePickers MUG.

Newsletter Information

We welcome members’ contributions to the newslet-
ter. Submission deadline is the 20th of the month.
Please send articles to the editor for that month. Bob
is the editor next month. ApplePickers accepts amem-
ber’s classified ad free of charge once every 6 months.
Business ads are also accepted.

Email pr@applepickers.org for more information, or
visit our website: www.applepickers.org
Advertisement rates are as follows:

Business card size - 3" x 2.5" $60 per 6 months
Quarter page size - 3.75”"x 5" $100 per 6 months

All advertisement requests must be approved by the
board prior to inclusion in the newsletter. Full color or
grayscale ads have the same price. We request that
your ad be “camera ready” art. 300dpi is preferred.
Email ads to either newsletter editor

ApplePickers Message Boards

Come and join us at the ApplePickers’ new Message
Boards! Ask questions, read other ApplePickers mem-
ber’s postings. See gossip and news and special an-
nouncements. The ApplePickers Message Boards are
a valuable and useful member benefit! Free subscrip-
tions for ApplePickers members. To join point your
browser of choice to www.applepickers.org, and click
on the Forum tab on the top of the website. If you
need an account or lost your password, please E-mail
Bob van Lier at bobv@applepickers.org.

New Information

As a new benefit to members, we offer the ability to
have your own @applepickers.org e-mail address.
If you are interested in setting up an ApplePickers
e-mail address for yourself, please send an e-mail
request to Bob van Lier and give us the address you
wish to have and whether you just want a forwarding
account or a regular e-mail account.

& ApplePickers

MACINTOSH USER GROUP
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Sorry, How Can | Not Help You?
By R Marcy

y wife and | just recently came back from a vaca-

tion in Montreal Canada. One of the things we
found was that our internet service was down. | did
the usual stuff of unplugging the modem, counting
to 10 then re-plugging back in, but no luck.

| checked the router, it was good. Modem seems OK.
Time to call the company for help.

Not wanting to name names, lets just pick a letter and
call the company “C" | called “C” on Saturday the same
day. After going through all of the automated junk |
finally was able to speak to a live body.

Yes, my system looks to be down. | have tried this and
that? Yes | have. OK we need to send a tech out. We
finally wringed out a time for Monday between 3 and
5pm. | can live the weekend with out the net.

Sunday | am working on the Mac and the phone rings.
Its “C". My connection is back up. Why, yes it is! Happy
happy joy joy!! Looks like all is well so Monday’s ap-
pointment is canceled.

Fifteen minutes later its down again. | call “C". Can't
get my Monday appointment back. Now its Tuesday
between 3 and 5pm. Oh, by the way “C", please check
the pole. I think the problem is there.

Monday | get home at 2:30. “C” is already here. They
say they don't need to come in, they checked the pole
and the problem is there. (Think | told them that on
the phone). They have called it in and it will be 24 to
48 hrs. (Strong union, they don't work the pole.)

Its now Friday 3pm. No internet. | call “C". Oh.. you are
scheduled for today between 7 and 7 p.m. They don't
have to come in so you don't need to be home.

7 p.m. comes and goes, no internet. | call Sunday. |
moan and groan that it has been a week. Gee, we are
really sorry. They are usually much faster than that.
You know you can get a credit don't you?? Yes... but
that doesn’t help me with my problem. They will be
there Monday.

Monday night 9:56pm. Its dark outside. Its dark in-
side. I call“C". Well let me look. Oh | see that they have
put out a SRO that has been approved by the supervi-
sor. This will involve a contractor in you area and its
scheduled for Thursday June 25th for all day 7am to
7pm. Have a pleasant evening and thank you for call-
ing “C". What happened to Monday? Why is this SRO
contractor approval thing just happening now? Does
anybody care? (John Adams - musical 1776)

Great news! It's Wednesday and the internet had de-
cided to come out to play. It's slow but it is working.

| am finally able to read all of the junk mail that has
been accumulating and maybe get a few updates.

Well nix on the updates. Its so slow that they time out.
They told me my date was Thursday, so we will wait
until tomorrow to see what gives.

Thursday is here. Its now 3pm and | hop on for the
first time today. It seems to be back to normal. Well
all I can say is its about time. Today is day 13 from the
first day | called.

| will wait until the weekend to make sure all seems
well before | call back with my reference number and
start my hunt for a credit.

So what’s the moral of this story? Beats me. Monopo-
lies are bad? You have your choice of one company
each in your area for cable, DSL or satellite and its a
crapshoot on which one you pick.

Maybe its that even though we are suppose to be a
very techo advanced society, we have certain things;
internet service, cell phones, that the service we get
pretty much sucks. What can you do? Well there’s al-
ways dial-up!




Review: Nikon CoolPix L20 Digital Camera

By Irv Haas - The Review Guru

f you have been looking for a compact camera with Memory
10 MP (megapixel) resolution, motion detection
and a large 3”LCD screen at a price that won't break  Like most digital camera, the L20 uses memory cards

the bank, check out the Nikon Coolpix L20 Digital to store photos. This Nikon uses the standard SD
Camera. cards or the newer SDHC (High Capacity) cards for

storing photos. The L20 comes with 20MB of internal
This camera demonstrates how far camera storage that will yield 2-18 photos depending on
technology has come in both features and pricing. resolution.

This camerais a 10 MP compact camera that

measures only 3.8” (w) x 2.4” (h) x 1.2”(w). Although  With an SD card, you can expect up to 2210 photos
this camera retails for $129.99, discounts can be on one 2GB card. With larger capacity SD cards, your
found as low as $110. number could go up even higher.

Nikon’s Technology Features

Nikon has provided a lot of technology into the L20.
Check out some of these technology features to
prevent shooting errors:

v Motion Detection automatically controls
the shutter speed and ISO settings to
compensate for camera shake and subject
movement.

v' Easy Auto Mode with Scene Auto Selector
simplifies picture-taking by letting the
camera automatically select the best setting
to get great pictures. All you need to do is to
set the camera to Scene Auto Selector and
the camera changes settings automatically.

Basic Features

The MP resolution of 10 is amazing for a camera this v
small. Of course, this is not an important concern

for most enthusiasts unless you are into making

large prints. v

In-Camera Red Eye Fix™ fixes most instances
of red-eye in the camera.

Face-Priority AF is Nikon’s face-finding
technology that automatically focuses on up

The LCD screen size of 3"is huge for a camera of this to 12 faces in a group portrait.

size. You won't have any problems viewing your

images on this screen. The down side of all this is v
that for such a large screen, the control buttons are
unusually small, especially for someone with big

fingers.

Smile Mode automatically releases the
shutter when your subject smiles. No more
blank looks from your subjects!

v Blink Warning displays a warning message

This camera uses a 3.6X optical zoom. However should the camera detect that your subject
when coupled with a NIKKOR glass lens, you get blinked!

extremely sharp images.



v D-Lighting rescues dark or backlit images
by improving brightness and detail where
needed.

Color Choices

The trend these days is to bring out cameras in
various colors, similar to the iPod nano choices! The
L20 comes in red and blue.

Although these color choices may not be all that
significant, you will find that the different colors have
different prices as well depending on demand.

Mac Support

This Nikon camera technically does not have drivers
that work with Macs. However, it seemed to work
well with iPhoto and instantly downloaded its
photos without installing the included CD software.

This camera, like those from other manufacturers,
does not need Mac support, since iPhoto makes it
easy to download pictures from any camera.

If you feel you need support, Nikon includes their
Nikon Transfer software program to move images
from the camera directly into your Mac.

Battery Options

The Nikon L20 uses standard AA alkaline batteries
that are included.

However, you should prefer to use either AA
rechargeable lithium or Ni-MH that will give you
longer battery life. Repeated charging will also save
you money in the long run.

Negatives

All cameras have some shortcomings. You just need
to find one you can live with.

A basic problem mentioned earlier is that the large
3.0” LCD screen reduces the button sizes on the rear
of the camera. This could be a real problem for those
with large hands and fingers.

Removing images is a simple task. With the Nikon
L20 just press the trash icon to remove your last
image. Most other cameras offer you a delete one
or delete all option.

The L20 makes things more difficult. With this
camera however, if you want to delete multiple
images you have to get into the sub-menus to Select
All before you delete them. A simple option on

the trash button to delete one or all would have
eliminated this problem.

Another drawback is Nikon’s omission of a viewing
lens. Yes, the camera has a nice 3-inch LCD, but with
light changing, it would be nice to occasionally look
through the viewfinder as well. | realize that Nikon
like other camera manufacturers can save money by
eliminating this feature.

Conclusion

The Nikon Coolpix L20 Digital Camera is hard to beat
for someone looking for a small digital camera to
easily place in pocket or purse. The features of this
camera, usually found in more expensive cameras,
are an added bonus.

For under $130, as a primary camera for someone
new to digital photography or as a backup camera
for an experienced photographer the L20 is one
serious contender.




Buying Cables: Online VS. Retail

By Irv Haas - The Review Guru

f you have ever needed a cable for your Mac,

your cell phone, printer, etc. you probably visited
your local retailer and bought one. What many
consumers are not aware of is the wide disparity of
prices available.

USB Cables

Since cables are relatively inexpensive to produce,
prices are all over the place. Take that standard
A/B 6-ft. USB printer
cable. A large national
firm with several local
stores sells their own
generic cable for
$36.99.

You've already

committed to buy that great printer you always
wanted. Now the salesperson asks if you need a
cable to go with it. Of course, you say “yes”since it is
so convenient to buy the printer and the cable at the
same store. But do you really know how much you
are overpaying for this cable?

A quick check on eBay finds sellers for this cable

as low as $3.39—including free shipping. A quick
calculation finds that you are saving nearly $34 by
saying “no” to the salesperson and buying it on your
own.

HDMI Cables

If you've bought that new HDTV set, the salesperson
has probably told you that you need one or more
HDMI (High Definition Multimedia Interface)

cables. These newer
technology cables carry
both video and audio
signals and are more
expensive to produce
compared to USB
cables. But just how
much more?

The same rules for buying USB cables apply to HDMI
cables. HDMI cables have performance standards to
insure you are buying the best cable for your TV. The
current version is 1.3 which is the latest standard.
This is very much like
802.11n is the latest
standard for routers. All
of the HDMI cables in
this comparison share
the same performance
standard. Prices range
from $4.88 to $99.99.

The big chain store that
sold you that expensive
USB cable wants to sell you a 6-ft. HDMI cable for

as low as $39.99. Of course, if you want the best
picture (signal), you want to get the best cable. That
same chain store offers a Monster Cable 6-ft. cable
for $99.99. For a short distance of 6-ft. the choice

of cable may not be that important. Both of these
prices are significantly higher than eBay’s price of
$4.88.

Ethernet Cables

Include Ethernet
or CAT-6 cables
in this pricing
confusion.
These are the
standard cables
you use to hook
up your network
to your server

or printer. This
comparison is
for a 25-ft. Cat 6 network cable. Your retailer sells a
generic one for $29.99. The eBay price is as low as
$6.69. Again, quite a price difference.

Website Vendors

Consumers have other choices besides chain stores
and eBay for purchasing cables. There are website
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vendors that specialize in cables. These are reliable
in terms of speed of shipment and accuracy and
provide quality cables at a reasonable price.

v" Monoprice - This California site provides
some of the best prices on the Web. Their

Web address is: http://www.monoprice.
com/home/index.asp

v Cables for Less — A local Web vendor in
Mooresville, IN sells quality cables “for less.”
If you pick up your cables at their site, there
is no shipping charge. Their web address is:

http://www.cablesforless.com

v Cable & Connector Technologies — This
Dayton, Ohio vendors also sells a variety of
cables at reasonable prices. Being in Dayton,
most orders arrive in one day. Their website

is: http://www.callcct.com.

Conclusion

The next time you make a major purchaser and the
salesperson asks you if you want cables “to go” just
be aware of your online pricing options. They could
save you a bundle.

Retail eBay Monoprice | Cables Less | CCT Cable |
USB 6-ft 36.99 3.39 .86 1.49 2.00
HDMI 6-ft. 39.99 4.88 3.56 6.59 9.98
Cat 6 25-ft 29.99 6.69 3.59 5.59 6.45
TOTAL 106.97 14.96 8.01 13.67 1843
Difference 92.01 98.96 93.30 88.54

You can save an average of $93.20 by buying online.
Of course, you have to be knowledgeable enough to
buy the correct cable. Returns can be costly in terms
of both time and money, especially if you receive the
wrong cable and have to return it. Of course, a store
return would be much simpler.

Having just purchased a new cell phone, | needed
accessories such as case, flash memory, cable etc.
The dealer wanted between $20 and $30 for each of
these items. Instead | purchased them on eBay for
$3-$5 each including shipping for even more savings.
The same rules apply for cell phones accessories as
do cables in general.



http://www.monoprice.com/home/index.asp
http://www.monoprice.com/home/index.asp
http://www.cablesforless.com
http://www.callcct.com

Review: Logitech Pure-Fi Express Plus

By Irv Haas - The Review Guru

f you've been looking for an easy way to listen to

your iPod at home or in the office without using
those pesky headphones or on your Mac, try the
Logitech Pure-Fi Express Plus™, portable speaker
system/alarm clock for iPods and iPhones.

Justinsert your iPod into the Pure-Fi Express Plus™,
select your song/album and you've got great sound
thanks to Logitech’s =
omnidirectional
acoustic technology.
In last month'’s
newsletter, we
reviewed Logitech’s new omnidirectional speaker
system that directs sound in a 360° arc instead of just
in front of you.

Features

This portable music system uses the same
technology to produce great sound in a small
package. Its small size fits on to your desk or bedside
nightstand very easily. The dimensions are 13-1/2"
(w) x 3-1/2"(d) x 4” (h). The unit’s two 3” speakers will
truly amaze you. You'll swear you are listening to a
much larger speaker system.

One of the unique features of this docking station is
that it includes a wireless remote to select tracks as
well as volume. The remote’s small size of 2-1/2" x
1”and %" thin could prove to be a problem since it
would be extremely easy to lose.

Besides being a great music player, the Logitech
Pure-Fi Express Plus™ can also be used as a charger
for your iPod/iPhone. This is just an alternate way of
charging your iPod/iPhone without using the dock
or USB connector.

_ This Logitech unit,
like many others on
the market also has
the ability to be used
as an alarm clock

to wake you. Don't

want to get up so soon? Logitech has also included a
Snooze button as well.

Logitech calls this a portable unit since you can take
it wherever you go with its recessed handle. The AC
power adapter is standard, but you can also run this
unit on 6 AA batteries (not included).

Logitech has thought of everything
in designing the Pure-Fi Express
Plus™. For current models, just
insert into the dock. Logitech .
includes 4 iPod dock connectors so |
that all iPods with a dock connector !
will work with this unit. If you own
one of the original classic iPods,
justinsert the accessory cable from |
the Line-Out port on the Pure-Fi
Express Plus™ to the headphone
jack on your iPod.

Want to see the time? This unit also has a bright
amber clock display. The digits are 34" high for easy
reading across the room.

Installation

Using this device could not be easier than following
1-2-3:

1) Plug in the AC adapter into the wall & iPod

2) Slide your iPod into the dock connector or
plug the auxiliary cable into your older iPod
and run the other end into the on stage

3) Press Play on your iPod.

Try and set up your new Mac that easily!
Included Items

1) Logitech Pure-Fi Express Plus™ Plus Music
Docking Station

2) AC power adapter

3) Wireless remote

4) 4iPod dock adapters



Evaluation

Logitech has iPod/iPhone speaker systems from
$59.99 to $200 and the Pure-Fi Express Plus™ fits
in the middle of their lineup.

At first glance, the Pure-Fi Express Plus™ may
seem to be expensive at $99, but the Internet
offers deals under the $80 mark as well. If you
want this same speaker system without the alarm
functions, Logitech has the Pure-Fi Express™ for
$79.99.

You are not going to get better sound unless

you want to hook up your iPod/iPhone to an
expensive receiver and 5-channel speakers.

The real benefit of the Pure-Fi Express Plus™ is
that since it is so small, it can be moved to any
room in your house for convenient listening. With
the optional battery power, you can just take it
anywhere.

Go to local dealer and listen to the Pure-Fi Express
Plus™ for yourself. Your ears will be amazed!
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Compatibility

* Supports iPhone and all iPod models with
dock connector

* Supports 1st generation through 3rd genera-
tion iPod models (and other portable music players)
via 3.5 mm auxiliary input

* Uses the Apple Universal Dock specification




Mac 911 Tips
By Christopher Breen mac911@macworld.com

Bulk edit Address Book data

Reader Andrew Jacobs is interested in making big
changes to contacts in Address Book. He writes:
“Recently, a large company | do business with moved its
headquarters and I'd like to change the address for all
my contacts who work for this company. Is there a way
in Leopard’s Address Book to change multiple contacts
atonce?”

Regrettably, Address Book doesn’t include a bulk-
edit feature, but there’s a way to use Apple’s TextEdit
to solve this one. Try this:

Start by launching Address Book and choosing File
-> Export -> Address Book Archive. This will create
a backup of all your contacts. Should something go
wrong, you can always return to this backup.

Now, create a group that includes the contacts who
work for this company (use Address Book’s Search
field to help in this effort, select all the results, and
then choose File -> New Group From Selection).
Name the group, select it in the Group pane, select
all the contacts in the group, and drag the contacts
to the Desktop to create a single vCard (.vcf) file.

(I suggest dragging the contacts to the Desktop
rather than the Group because, at least in my testing,
when you drag a group that contains contacts with
embedded images to the Desktop, the resulting
vCard file can’t be edited with a text editor.)

Open this vCard file with Apple’s TextEdit. Choose
Edit -> Find, and in the resulting Find window

enter the company’s address in the Find field in

this format: 123 Main Street;Anytown;CA;12345.
(You can just copy the text from the file and paste it
into the Find field.) In the Replace With field, enter
the new address along these lines: 321 Broadway
Avenue;Thistown;AK;54321. Click the Replace All
button and close the Find window. The previous
address should be replaced with the new address for
all the contacts within the file. Save the file.

Drag the file you just saved onto Address Book’s All
group entry. A sheet will appear that asks if you're
sure you want to import X number of cards. Below

this question is an entry that reads “X cards are
duplicates and will be updated.” Click Import and
the contacts you originally selected will have their
information updated with the changes you made in
TextEdit.

Accessing a Mac when you don’t know the
password

Reader Sabrina has a common, but potentially
delicate, question. It goes a little like this:

I was given my mother’s iMac because she passed away
but | don’t know the password. How can | gain access to
this Mac?

| suggest this question is a little delicate because
you could use the method I'm about to describe

to access any Mac. And that may be a problem for
parents who want to keep kids out of their stuff
(and vice versa). On the other hand, situations such
as yours (as well as problems that come up when
you purchase a used Mac that hasn’t been properly
cleared) invite a response.

That response is this in regard to OS X 10.5: Locate
that Mac’s installer disc or a recent OS X installer disc
(aTiger or Leopard disc, for example). Insert that
disc into the Mac’s media drive and hold down the
keyboard’s C key to boot the Mac from that disc.

When the Mac boots you'll be asked to choose

a language. Do that and click the right-pointing
arrow icon to continue. When the Welcome screen
appears wait for the menubar to materialize and
choose Reset Password from the Utilities menu.

In the resulting window choose the user whose
password you want to change from the Select a User
pop-up menu. Enter and confirm a password in the
appropriate fields and, if you like, enter a hint for the
password. Click Save to make the change.

Note that when you've reset the Administrator’s
password you haven't reset the login keychain
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password--that password remains as it was when it
was originally set. What this means is that you'll be
able to do all the things an Administrator can--install
applications and muck with all the Mac’s system
preferences, for example. You can’t, however, access
keychain items (web site passwords, for example)
saved in that login keychain without the password
originally used.

Oh swell, I hear parents saying. You've just given my
kid the key to taking over my Mac. Thanks so much!

Fortunately, there’s something you can do. Boot your
Mac from that installer disc again, find your way to
the Welcome screen, and from the Utilities menu
choose Firmware Password Utility. In the window
that appears click the Change button, then enable
the Require Password to Change Firmware Settings
option and enter and verify a password. Click OK
and your Mac is now protected with a firmware
password.

Which means what? It means that if your kid starts
up your Mac with an installer disc in the media

drive and presses the C key to boot from the disc,
the Mac will ignore that key press and move to the
login screen. If the kid’s really savvy and presses the
Option key to move to the screen where you choose
a device to boot from, a padlock icon appears with a
text field below. If said kid doesn’t enter the correct
firmware password in that text field, he or she won't
be able to boot from the disc.

However (and this is an important however), if
you've logged into your Mac as an administrator
and walked away from your Mac without logging
out, any passer-by can then shove the installer disc
into the Mac’s media drive, boot from that disc by
choosing it in the Startup Disk system preference,
and then muck with the administrator and firmware
passwords. For this reason, be sure to log out of
your account before leaving your Mac if you fear for
your Mac’s safety. (The Log Out After X Minutes of
Inactivity option in the General tab of the Security
system preference can help with this.)

Making sense of OS X's folder structure

Reader Mark Walerysiak is frustrated by what he
views as redundancy in OS X. He writes:

I'm very happy with all things Apple but one thing I've
never understood about OS X is the multiple Library
folders. Today | was looking for the Startupltems

folder because | had to delete something. | went to
Hard Drive/System/Library/ Startupltems. And | found
nothing in that Startupltems folder. | then went to my
Home folder/Library, only to find no Startupltem folder.
Finally, | found what | was looking for in Hard Drive/
Library/Startupltems folder. What the heck is going on?

This question goes to the heart of the way OS X
organizes users and directories. It breaks down this
way:

Items in the System folder are for OS X's use--items in
its Library folder are, for the most part, placed there
when OS X is installed or when the OS is updated.
Unless you're geeking out, there are few reasons to
venture into this folder.

The Library folder at the root level of the hard drive
is often populated with third-party items installed
by an Administrator. In the case of startup items,
they're placed here because they may be needed
by every user who has an account on that Mac. If a
user doesn’t have access to a particular application
that uses one of these startup items—because they
have a controlled account, for example--no worries.
It doesn’t hurt to have that item loaded. It would
hurt, however, if a startup item was loaded for one
account and not another.

This helps explain why there’s no Startupltems
folder in the Library folder within your user
account. (Underscoring this notion is the fact that
startup items load before a user logs in.) Note
that Startupltems are not the same thing as the
applications you've designated as Login Items
for your account. Startupltems work deeper-level
background mojo than Login Items.

Continuedon 12
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Application for Membership Mac 911 Continued

The Library folder within a user’s folder contains,
as you might expect, items that apply to that
specific user--preferences, audio files, plug- ins,
mailboxes, log files for applications used by that

Membership has its’ benefits.
An ApplePickers membership offers the following
benefits, plus many more:

« The ability to view and post on our user, and so on.
message boards.

« The ability to have your own email This is the folder you want to dig around in when
address - ____@applepickers.org something in your account is acting up.

« The ability to place a free ad every
6 months.

« The ability to participate in all club
raffles and auctions

Name
Additional Family Members
Address
City State Zip Beth Weber
store ma: nagear
Phone W Coffea Mastaer
Email (Required) Starbucks Coffee Company
96th & Mus!grs
: ; 7205 E 96th Str
New Member (Single/Family $25) I di:napu‘]is. e e250
Renewal ($25)
317/595-5574 Direct Line
starbucks.com/jobs

| prefer to receive my newsletter: @ Primind on 100% recycied pa, 100% poat-consumer materil,
via email notice (download via web)
As an email attachment

Mail your application along with a check for $25 made
payable to ApplePickers to:
ApplePickers
PO Box 20136

Indianapolis, IN 46220

iPhone 3G

Ihe fastest, most powerful iPhone yet.




